
Spatial Analysis of Vermont’s Wildlife Corridor 

Methodology, Data Sources, Key Findings, and Replication Guide 
Lucas Farrell and Louisa Conrad · Big Picture Farm, Townshend, Vermont 
countusinvt.org · April 2026 

 

1. Purpose 
This document describes the methodology and data sources for two spatial analyses conducted in QGIS 
3.44 using publicly available Vermont state datasets. It is written as a replication guide — anyone with 
QGIS and an internet connection can reproduce these findings using the same publicly available data. 
We welcome verification, scrutiny, and challenge. The analyses were conducted to answer two questions: 

 

1.​ What share of Vermont’s highest priority wildlife corridor is already enrolled in Current Use or 
permanently conserved? 

2.​ What share of Vermont’s total land area is enrolled in Current Use or permanently conserved under 
a corrected accounting? 

 

Both analyses use only official public datasets maintained by the Vermont Center for Geographic 
Information (VCGI) and the Vermont Agency of Natural Resources (ANR). All data sources are publicly 
available and downloadable from the Vermont Open Geodata Portal. 

 

2. Data Sources 
 

Dataset Source / URL Key Fields Used 

VT Data — Vermont 
Highest Priority 
Connectivity Blocks 
(Vermont Conservation 
Design) 

VCGI / Vermont Open Geodata 
Portalgeodata.vermont.gov 

Block geometry; cons_pct (% 
permanently conserved within 
block) 

VT Data — Current Use 
Program Properties (April 
1, 2026) 

VCGI / Vermont Open Geodata 
Portalgeodata.vermont.gov/datasets/VCGI::vt-
data-current-use-program-properties/aboutPu
blished April 1, 2026 — first official public 
dataset joining enrollment data with statewide 
parcel geometry 

FS_VCGI_OP (enrollment status 
flag); ACRESGL (listed acreage); 
SPAN (parcel identifier) 

VT Data — Protected 
Lands (Vermont Protected 
Lands Database, VPLD) 

VCGI / Vermont Open Geodata 
Portalgeodata.vermont.gov 

POLYID (conserved parcel 
identifier); geometry 

VT Data — Statewide 
Parcels (Grand 
List-Joined) 

VCGI / Vermont Open Geodata 
Portalgeodata.vermont.gov 

SPAN; PROPTYPE; ACRESGL; 
LAND_LV; RESCODE; TOWN; 
OWNER1 



VT Data — State 
Boundary 

VCGI / Vermont Open Geodata 
Portalgeodata.vermont.gov 

State land area denominator 

Vermont land area 
reference 

VCGI — How to Reference Vermont’s Land 
and Water 
Areavcgi.vermont.gov/resources/how-and-edu
cation-resources/how-reference-vermonts-lan
d-and-water-area 

Vermont land area: 5,899,041 
acres (Census 2022 TIGER/Line, 
land only) 

 

All layers were reprojected to NAD83 / Vermont (EPSG:32145), a projected coordinate system in meters, 
before any area calculations were performed. 

 

3. Corridor Analysis — Vermont’s Highest Priority Connectivity Blocks 
This analysis was conducted in March 2026. It examined what share of Vermont’s 433 VCD Highest 
Priority Connectivity Blocks is already enrolled in Current Use or permanently conserved. 

3.1 Methodology 
 

3.​ Fix Geometries was applied to both the VCD Highest Priority Connectivity Blocks layer and the 
VCGI Protected Lands Database layer to resolve any invalid geometries before spatial operations. 

4.​ Intersection: The enrolled parcel layer (Current Use Program Properties, filtered to FS_VCGI_OP 
IS NOT NULL, yielding 20,158 enrolled parcels) was intersected with the corridor blocks layer to 
identify enrolled parcels within the corridor. 

5.​ Intersection: The VPLD layer was intersected with the corridor blocks layer to identify permanently 
conserved parcels within the corridor. 

6.​ Union: The enrolled corridor layer and conserved corridor layer were merged using the Union 
operation to create a combined enrolled-or-conserved layer within the corridor. 

7.​ Difference: The combined enrolled-or-conserved layer was subtracted from the corridor blocks layer 
using the Difference operation to produce the genuinely at-risk layer — corridor land that is neither 
enrolled nor permanently conserved. 

8.​ Area calculation: $area * 0.000247105 was applied to each output layer to convert square meters to 
acres. 

9.​ Parcel classification: A four-way attribute join classified all parcels intersecting the corridor as: (1) 
both enrolled and conserved, (2) enrolled only, (3) conserved only, or (4) neither — at-risk. This 
classification was used for ownership and tenure analysis. ACRESGL (grand list acreage) was 
used for this classification; see limitations in Section 5. 

 

3.2 Key Findings — Corridor 
 

Metric Value 

Total corridor area (433 VCD Highest Priority 
Connectivity Blocks) 

2,837,622 acres 

Enrolled in Current Use or permanently 
conserved (deduplicated) 

2,072,617 acres (73.1%) 



Genuinely at-risk (neither enrolled nor 
conserved) 

765,005 acres (27.0%) 

At-risk parcels — total count (parcel 
classification) 

28,481 parcels 

At-risk parcels below 25-acre Current Use 
minimum 

25,773 parcels (90.5%) 

At-risk parcels 25 acres or above (Current 
Use eligible) 

2,708 parcels (9.5%) 

At-risk acreage reachable at 10-acre corridor 
minimum 

84.5% of at-risk acreage 

At-risk acreage reachable at 5-acre corridor 
minimum 

92.7% of at-risk acreage 

Median enrollment date (enrolled corridor 
parcels) 

2008 (nearly two decades ago) 

Enrolled corridor acres managed 20+ years >50% 

Enrolled corridor acres managed 30+ years >25% 

Average land value — at-risk parcels 
(sub-25-acre resort corridors) 

$12,664 per acre (Stowe: $95,398; Ludlow: $48,912) 

Average land value — enrolled corridor 
parcels 

~$2,500 per acre 

Out-of-state ownership — high-value resort 
corridor parcels 

45–87% depending on town 

 

3.3 Note on cons_pct 
The cons_pct field in the VCD Highest Priority Connectivity Blocks layer measures the percentage of 
each block that is permanently conserved. It was used in LURB’s rulemaking as a proxy for protection 
status. Our analysis found that the statewide weighted average of cons_pct across all 433 highest priority 
blocks is approximately 36.8% — a figure that excludes all enrolled Current Use land. This compares to 
73.1% when enrolled working lands are included. The 36-percentage-point gap between these figures 
represents the enrolled working landscape that the current regulatory framework cannot see. 

Importantly, cons_pct was designed as a development threat metric — measuring how much of a block is 
permanently protected from development pressure — not as a measure of ecological function or 
conservation quality. VCD designated the Highest Priority Connectivity Blocks based on ecological quality 
and size within each biophysical region, not on cons_pct values. 

 

4. Statewide Analysis — Vermont’s Conservation Baseline 
This analysis was conducted in April 2026. It calculated the deduplicated statewide area of Vermont 
covered by enrolled Current Use parcels or permanently conserved parcels, expressed as a percentage 
of Vermont’s total land area. 

4.1 Methodology 
 



10.​ Layer preparation: The full Vermont grand list parcel layer (344,317 features) was filtered to 
enrolled parcels only using the expression FS_VCGI_OP IS NOT NULL, yielding 20,158 enrolled 
parcels. Fix Geometries was applied to both this filtered layer and the Vermont Protected Lands 
Database. 

11.​ Union: Vector > Geoprocessing Tools > Union was applied to the filtered enrolled parcel layer 
(20,158 parcels) and the VPLD layer. This merges the two polygon layers, preserving all geometry 
including overlapping areas. 

12.​ Fix Geometries: Fix Geometries was applied to the Union output to resolve any invalid 
geometries produced at intersection boundaries. 

13.​ Dissolve: Vector > Geoprocessing Tools > Dissolve was applied to the fixed Union output with 
no dissolve fields, merging all features into a single polygon representing all enrolled-or-conserved 
land in Vermont. 

14.​ Area calculation: The dissolved layer’s area was calculated using the Python Console: 
print([f.geometry().area() * 0.000247105 for f in iface.activeLayer().getFeatures()]). This produces 
the deduplicated statewide enrolled-or-conserved acreage by computing area directly from the 
dissolved geometry rather than summing attribute fields. 

 

4.2 Key Findings — Statewide 
 

Metric Value 

Enrolled in Current Use parcels (April 1, 2026) 20,158 parcels statewide 

Enrolled + permanently conserved (deduplicated 
dissolved area) 

3,615,600 acres 

Vermont total land area (Census 2022 
TIGER/Line, land only) 

5,899,041 acres 

Vermont enrolled or conserved as percentage of 
land area 

61.3% 

Additional acreage needed to reach 70% 
conservation mosaic 

~513,000 acres 

Additional acreage needed to reach 80% 
conservation mosaic by 2050 

~1,100,000 acres 

 

4.3 Why the Deduplicated Dissolve Matters 
Simply summing enrolled acreage and conserved acreage would double-count parcels that are both 
enrolled in Current Use and covered by a conservation easement. The Union + Dissolve methodology 
eliminates this double-counting by merging all enrolled and conserved polygons into a single dissolved 
shape before measuring area. The resulting figure represents the true footprint of the 
enrolled-or-conserved landscape without overlap inflation. 

Cross-check against official sources: The Vermont Department of Taxes confirms 2.57 million acres 
enrolled in Current Use as of 2024 (Vermont Legislature House Ways and Means Committee 
presentation, January 21, 2025). Our April 1, 2026 dataset shows 20,158 enrolled parcels — consistent 
with the Dept. of Taxes figure of “more than 19,000 parcels.” The official VHCB/ANR Phase 1 
Conservation Inventory (2024) shows 27% of Vermont permanently conserved under Act 59’s definition, 
which excludes all enrolled working lands. Our 61.3% figure adds enrolled working lands to that baseline 
using a deduplicated spatial analysis. The two figures are not in conflict; they measure different things 



under different definitions. Our 61.3% figure has not previously been calculated using parcel-level spatial 
data and is not contradicted by any existing public source. 

Vermont’s grand list parcel boundaries include water bodies, road rights-of-way, and other features within 
legal parcel boundaries. This means the enrolled parcel layer’s geometry area is slightly larger than 
Vermont’s official land-only area. The 61.3% figure reflects this: it measures the footprint of enrolled and 
conserved parcel boundaries as a share of Vermont’s land area, which is the most accurate available 
measure of the enrolled-and-conserved landscape using parcel-level data. 

 

5. Known Limitations 
 

•​ ACRESGL overcounting: The parcel attribute ACRESGL records the full grand list acreage of each 
parcel, not the portion clipped to the corridor boundary. Parcels that straddle the corridor boundary 
contribute their full listed acreage to parcel-level statistics, overstating at-risk acreage in the parcel 
classification. For this reason, aggregate acreage figures (73%, 765,005 acres, 61.3%) are derived 
from spatial geometry calculations, not ACRESGL sums. ACRESGL-based figures (acreage 
threshold analysis, ownership profiles) are used only for directional analysis and are noted as 
estimates. 

•​ VCGI currency: The Vermont Protected Lands Database reflects protection status as of the most 
recent VCGI update. Recently acquired easements or fee parcels may not yet be represented, 
meaning the conserved acreage figure may be slightly understated. 

•​ UVA layer currency: The April 1, 2026 Current Use Program Properties dataset reflects enrollment 
status as of April 1, 2026 (the Vermont tax year date). Parcels that enrolled or withdrew after April 1 
are not reflected. 

•​ Owner classification: Owner type categorization (individual/family vs. institutional vs. out-of-state) is 
based on keyword analysis of the OWNER1 field in the grand list. Family LLCs holding working 
farmland may be misclassified as institutional entities. The direction of error would understate 
individual/family ownership. 

•​ Enrollment tenure: Tenure figures are based on the earliest ENTRYYEAR record for each SPAN in 
the UVA layer. Parcels that withdrew and re-enrolled would show the re-enrollment year rather than 
the original enrollment date, potentially understating long-term stewardship tenure for some parcels. 

•​ Parcel boundary vs. land area: Vermont parcel boundaries include water bodies and road 
rights-of-way within legal boundaries. This causes enrolled and conserved parcel geometry to 
slightly exceed Vermont’s official land-only area denominator (5,899,041 acres). The 61.3% figure 
reflects this boundary-inclusive measurement. 

 

 

6. Data Availability 
All data sources used in these analyses are publicly available from the Vermont Open Geodata Portal 
(geodata.vermont.gov). Every step in Sections 3 and 4 can be replicated using these datasets. If your 
results differ from ours, we want to know. The following datasets can be downloaded directly: 

 

•​ Current Use Program Properties: 
geodata.vermont.gov/datasets/VCGI::vt-data-current-use-program-properties/about 



•​ Vermont Protected Lands Database: 
geodata.vermont.gov/datasets/VCGI::vt-data-protected-lands/about 

•​ VCD Highest Priority Connectivity Blocks: 
geodata.vermont.gov/datasets/VCGI::vermont-highest-priority-connectivity-blocks/about 

•​ Vermont Statewide Parcels: geodata.vermont.gov 
•​ Vermont State Boundary: geodata.vermont.gov/datasets/VCGI::vt-data-state-boundary-1/about 

 

Full QGIS project files, intermediate outputs, and the at-risk parcel CSV are available upon request. If you 
are attempting to replicate this analysis and run into questions about the methodology, we are glad to 
help. Contact: lucas@bigpicturefarm.com 

 

 

Analysis conducted March–April 2026 using QGIS 3.44. All data sources are publicly available ANR/VCGI datasets. 
countusinvt.org 
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